[image: ]MIS 204 Lesson 4 Hands-on Activity –
Using EXCEL for Decision Support Modeling

Introduction
Willy Wonka is considering starting a production line to produce fizzy lifting drinks.  As Chief Oompa Loompa (COL) you have access to a wide variety of financial data to help you determine whether bringing the new production line on will be a smart investment or not.
In this exercise you will create a decision-support model.
This assignment will be a bit more of a challenge than previous assignments, but it relies on the basics you learned in the previous lessons, especially the creation of formulas.

Organization of the DSS Model
As you learned in the previous lessons, it is always good practice to separate constant data from your calculations and inputs.  In this exercise, your spreadsheet will have the following major sections:  constants, inputs, summary of key results, calculations (new product line) and calculations (no new product line). The spreadsheet will also have other sections that will be described in greater detail later.

Step 1: Create a “Shell”
The first step is to take some time and organize and format your spreadsheet. Create a new blank spreadsheet and then save with the following naming convention:  last name + first initial + HO4; e.g., doejHO4.xlsx.
Next, rename the default worksheets (Sheet1, Sheet2) to DSS Model and Income and Cash Flow respectively.
Step 1a: Creating the DSS Model Shell
1. Click on the DSS Model worksheet. In cell A1 type Product Line Investment Analysis.
2. Next you need to create each of the sub sections of this worksheet. Click in cell A3 and type Constants. In cells B3, C3, and D3 type 2012, 2013, and 2014 respectively as your DSS model projects three years out.  The constants for your model are Tax Rate and Loan Amount for New Product Line; enter them in cells A4 and A5 respectively.
3. [image: Macintosh HD:Users:test:Desktop:Screen Shot 2013-04-29 at 12.56.00 PM.png] Format the column headers: 14pt font, Bold. Cells with column headers should have an underline. Adjust column widths to fit data.    Merge and center the title in cell A1 across all columns in the model. Make the title 16pt font, bold. Done correctly your spreadsheet should now look like this:

4. Now repeat the process above for the sections Inputs, Summary of Key Results, Calculations (with new product line), and Calculations (no new product line). The entries you need for each section are described below:
	Inputs
	Summary of Key Results
	Calculations (New Line)
	Calculations (No New Line)

	Economic Outlook (R = Recession, B = Boom)
	Net Income After Taxes 
(New Line)
	Total Sales Dollars
	Total Sales Dollars

	Inflation Outlook (H = High, 
L = Low)
	End-of-year Cash on Hand (New Line)
	Cost of Goods Sold
	Cost of Goods Sold

	
	Net Income After Taxes (no New Line)
	Cost of Goods Sold (as a percent of Sales)
	Cost of Goods Sold (as a percent of Sales)

	
	End-of-year Cash on Hand (no New Line)
	Interest Rate for Business Loan
	



5. [image: Macintosh HD:Users:test:Desktop:Screen Shot 2013-04-29 at 1.03.09 PM.png]Make sure to format each section as you formatted the Constants section. When done, your spreadsheet should look like this:
All numerical values should be formatted as currency with no decimal places except the values for Tax Rate, Interest Rate, and Cost of Goods Sold as a Percent of Sales (for both New Line and no New Line), which should be formatted as percent with one decimal place.
The values in the Inputs section should be formatted as text.

6. Click on the Income and Cash Flow worksheet tab. Create the following tables on the worksheet using the same formatting guidelines as above:
	Income and Cash Flow Statements (New Line)

	Beginning-of-year Cash on Hand

	Sales (Revenue)

	Cost of Goods Sold

	Business Loan Payment

	Income before Taxes

	Income Tax Expense

	Net Income after Taxes

	End-of-year Cash On Hand



	Income and Cash Flow Statements (no New Line)

	Beginning-of-year Cash on Hand

	Sales (Revenue)

	Cost of Goods Sold

	Income before Taxes

	Income Tax Expense

	Net Income after Taxes

	End-of-year Cash On Hand



NOTE: Each table contains values for the years 2012-2014 just as the previous tables did. All values in both tables should be formatted as currency with no decimal places. When finished, it should look like the table below:
[image: Macintosh HD:Users:test:Desktop:Screen Shot 2013-04-29 at 1.09.44 PM.png]
Step 1b: Populate Initial Data.
1. As Chief Oompah Loompah you have data for the current year to enter into your model.  You only have data for Sales and Cost of Goods Sold for the year 2012; all other data is not available (NA).  Sales for 2012 were $350,000 and the Cost of Goods Sold was -$245,000 for 2012. Enter in those values in both1 Calculations tables in the DSS Model worksheet.

2. Next, create a formula for Cost of Goods Sold as a Percent of Sales for both Calculations tables.  In everyday language the formula is:
Cost of Goods Sold as a Percent of Sales = Cost of Goods Sold ÷ Total Sales * -1
You will need to create the formula above in EXCEL using the proper syntax. All other values for the year 2012 are NA.

3. Format the columns B, C and D to have center alignment.



1 The reason these values get entered into both Calculations tables is because they are the same for both regardless of whether the new product comes online or not.


Your table should be similar to this:
	Product Line Investment Analysis

	
	
	
	

	Constants
	2012
	2013
	2014

	Tax Rate
	NA
	
	

	Loan Amount for New Product Line
	NA
	
	

	
	
	
	

	Inputs
	2012
	2013
	2014

	Economic Outlook (R = Recession, B = Boom)
	NA
	
	

	Inflation Outlook (H = High, L = Low)
	NA
	
	

	
	
	
	

	Summary of Key Results
	2012
	2013
	2014

	Net Income After Taxes (New Line)
	NA
	
	

	End-of-year Cash on Hand (New Line)
	NA
	
	

	Net Income After Taxes (no New Line)
	NA
	
	

	End-of-year Cash on Hand (no New Line)
	NA
	
	

	
	NA
	
	

	Calculations (New Line)
	2012
	2013
	2014

	Total Sales Dollars
	$350,000
	
	

	Cost of Goods Sold
	-$245,000
	
	

	Cost of Goods Sold (as a percent of Sales)
	70.0%
	
	

	Interest Rate for Business Loan
	NA
	
	

	
	
	
	

	Calculations (No New Line)
	2012
	2013
	2014

	Total Sales Dollars
	$350,000
	
	

	Cost of Goods Sold
	-$245,000
	
	

	Cost of Goods Sold (as a percent of Sales)
	70.0%
	
	



4. The Tax Rate for 2013 and 2014 will be 33% and 35% respectively.  The Loan Amount to bring the new production line on in 2013 is $100,000.  The interest rate for any loan taken out in 2013 is forecasted to be 6% (interest rates for 2012 and 2014 are unavailable). Enter these values into your table.

5. The only initial data that you have for the tables on the Income and Cash Flow worksheet is for End-of-year Cash on Hand for the year 2012.  It is $15,000. All other values for 2012 are NA. Enter them in now for both tables. Center all cells in columns B, C, and D.

6. On both the DSS Model and the Income and Cash Flow worksheets change the Fill for cells containing NA to Orange, Accent 6, Lighter, 20% or 40%. Ensure that your choice uses a light orange background with a black font.

7. Finally, you want to highlight the cells in which you’ll enter your inputs into the model. Do so by highlighting cells C8:C9 (on the DSS Model worksheet) and selecting ‘All Borders’ from the drop-down menu for borders on the Font pane of [image: Macintosh HD:Users:test:Desktop:Screen Shot 2013-04-29 at 2.51.07 PM.png]the Home tab of the ribbon. You may have to redo the borders of the header cells C7:D7.

Step 1c: Create Initial Formulas
In this step you will create the formulas for your Income and Cash Flow worksheet. At this point you should be comfortable with the creation of formulas in EXCEL both within and across worksheets.  If you are not, please review the prior hands-on assignments and EXCEL videos.
Beginning of Year Cash on Hand = Prior Year End of Year Cash on Hand
Sales (Revenue) = Total Sales Dollars (from calculations section)
Cost of Goods Sold = Cost of Goods Sold (from calculations section)
Income Before Taxes = Sales + Cost of Goods Sold (No New Line)
Income Before Taxes = Sales + Cost of Goods Sold + Business Loan Payment2 (New Line)
Net Income After Taxes = Income Before Taxes + Income Tax Expense2
End of Year Cash on Hand = Beginning of Year Cash on Hand + Net Income After Taxes
[image: Macintosh HD:Users:test:Desktop:Screen Shot 2013-04-24 at 11.33.20 AM.png]You will have some cells with $0 in them after you’ve entered your formula.  This is correct. The reason you have $0 in the cell is because the formulas refer to cells that contain no data (e.g., Sales for the year 2013).  When done with this step your Income and Cash Flow worksheet should look like this:

Copy the formulas you just created to the year 2014 column.
2 The reason we add the Business Loan Payment and Income Tax Expense is because they will be a negative value in our table.


 (
1
)
Step 2: Using the IF() and PMT() functions.
One of the best features of EXCEL is that it comes with a bunch of predefined formulas (functions) that do common mathematical/statistical tasks.  EXCEL even provides functions to perform logical tests. You are going to use two of them on this step.
The first function you’ll make use of is EXCEL’s payment function – PMT(). This function calculates a loan payment based on the interest rate, length of the loan, and the amount of the loan.  To calculate the Business Loan Payment using the PMT() function perform the following steps:
Windows Users:
1. Click on cell C5 of the Income and Cash Flow worksheet.
2. Click on the Formulas tab on the ribbon.
3. [image: ][image: ]Click on the Financial icon on the Function Library pane of the Formulas tab and select PMT(). You will see this dialog box open up:

Mac Users: you will click on the Formula Builder icon, then type PMT in the search field, and you will get this dialog box: 



4. The Rate is contained in cell C21 on the DSS Model worksheet. Make this cell reference absolute.

5. The loan is a 10-year loan with annual payments. Therefore the Nper (total number of payments) is 10.

6. The Pv (present value – or amount of the loan) is contained in cell C5 on the DSS Model worksheet. Make this cell reference absolute.

7.  [image: Macintosh HD:Users:test:Desktop:Screen Shot 2013-04-24 at 11.40.37 AM.png]Click the OK button.

8. You should now see the value -$13,587 for the Business Loan Payment for the year 2013, and -$13,587 for Income Before Taxes and Net Income After Taxes. Note as well that the End-of-year Cash on Hand for 2013 and your Beginning-of-year Cash on Hand for 2014 values have updated as well!

9. Click on cell C5 of the Income and Cash Flow worksheet, and make sure all cell references are absolute. In this case, your formula should look like this after you’ve made the cell references absolute:
=PMT('DSS Model'!$C$21,10,'DSS Model'!$C$5)
10. Finally, copy the formula for Business Loan Payment to the appropriate cell for year 2014.



Step 3: Income Tax Expense
The next formula you have to create is one to calculate the Income Tax Expense. Willy Wonka Chocolates Inc. only pays taxes when there is income. If the company breaks even (zero income), or worse, loses money (negative income), it does not pay taxes. These conditions prevent you from using the simple formula of Income Tax Expense = Income Before Taxes × Tax Rate because that formula calculates an income tax regardless of whether the company makes money or not.
What you need to do is have your model perform a logical test to determine if the company made money. If the test is true, the formula gets calculated; otherwise a 0 gets placed in that cell.
1. Click on cell C7 on the Income and Cash Flow worksheet.
2.  Click on the Formulas tab of the ribbon. 
3. Click on the Logical icon and select the IF() function. You will get the following dialog box to open:







Figure 1 - Windows Dialog Box
[image: ]
Figure 2 - Mac Dialog Box

Notice that there are three fields you need to fill for this function. The first is Logical_test, and this is where you create a True/False test condition. The second is where you tell EXCEL what to do if the test result is true; the third is what to do when the condition is false.

4. Click in the Logical_test field. You want to test if Income Before Taxes is greater than (>) zero.  Income Before Taxes is stored in cell C6 of the Income and Cash Flow worksheet. Therefore, your test is:
C6 > 0
You can enter that formula by either typing it or by clicking on the cell containing Income Before Taxes then >0. 

5. Next click in the field for Value_if_true. If the test is true (company had income), you want the tax to be calculated. The formula is Income Before Taxes x Tax Rate or:
C6*’DSS Model’!C4*-1
Enter the formula.

6. Finally, you need to enter the Value_if_false.  In this case, type 0 (company pays no taxes if it makes no money or loses money).

7. Click the OK button.

You should now see the value $0 in the field for Income Tax Expense in the Income and Cash Flow Statements (New Line) table.

8. Now follow the same steps as above for the Income Tax Expense calculation in the Income and Cash Flow Statements (no New Line) table. Make sure to use reference the correct cell for Income Before Tax.

9. [image: Macintosh HD:Users:test:Desktop:Screen Shot 2013-04-24 at 12.02.21 PM.png]Finally, copy and paste the formulas for the year 2013 to the year 2014. You will probably need to adjust your column widths to fit. When done, your tables should look like this:
Step 4: Transfer data to Summary of Key Results table
[image: Macintosh HD:Users:test:Desktop:Screen Shot 2013-04-24 at 12.47.42 PM.png]You can now populate the Summary of Key Results table on the DSS Model worksheet. Create formulas to get the data from the appropriate cells on the Income and Cash Flow Statements worksheet.  Resize column width to fit .






Step 5: Set the conditions for the inputs.
The Inputs table is where you will be able to enter in conditional inputs to assess their impact on the future performance of the company.  There are two conditions: economic (boom or recession) and inflation (high or low). As a result there are four possible combinations of inputs:
Recession/High Inflation 
Recession/Low Inflation 
Boom/High Inflation 
Boom/Low Inflation
Each of these different combinations will impact the model differently.
You need to create two tables on your DSS Model worksheet to list these inputs and the values associated with them.
1. Click in cell F3 type and type ‘Economic Outlook Assumptions.’ Highlight cells F3:H3 and merge and center.

2. In cells G4:H4 type ‘New Line’ and ‘No New Line’ respectively. 

3. In cells F5:F6 type ‘Recession-R’ and ‘Boom-B’ respectively.

4. The values for table are as follows:
· R/New Line: 15%
· R/No New Line:  5% 
· B/New Line: 30% 
· B/No New Line:  20%

5. Format the cells F5:F6 and G4:H4 with Tan, Background 2, Darker 10% fill.

6. Make the table titles Font size 12pt, Bold.

7. Center the values in the table. 

8. Format the entire table with All Borders and the title cell with Thick Bottom Border. You should now have this table:


Now create this table starting in cell F11 for the inflation outlook (you will have to merge and center cells G13:H13, and G13:H14):
[image: ]
Your percentage values in this table should be in cells G13 and G14.
Step 6: Create Inputs-Based Formulas
You are now ready to create the formulas that rely on the inputs from the Assumptions tables.  As with the formulas you created to calculate Income Tax Expense on the Income and Cash Flow worksheet, you will need to use an IF() test to determine what input has been chosen.
Before you begin, place a ‘B’ in cell C8 (Economic Outlook for 2013) and an ‘L’ in cell C9 (Inflation Outlook). This is done so that you can see if you entered your formulas correctly.
The formula we need to calculate for Sales (Revenue) is:	Prior Year Sales × (1 + Sales Growth Rate).  Sales Growth Rate is determined by whether the economy is boom cycle (B) where it is growing, or recession cycle (R) where it is shrinking.
The reason we add 1 to the Sales Growth Rate is that next year’s sales are 100% (or 1) of this year’s sales plus the percent growth in sales this year.
1. Click on cell C3 in the Income and Cash Flow worksheet. 

2. Click on the Formulas tab, and then select IF from the Logical drop-down menu.

3. The logical test is whether the economy is booming (B) or in a recession (R). Click in the logical_test field. Then click in cell C8 on the DSS Model worksheet. Then type =”B”. Make the C8 cell reference absolute.  The formula displayed should be:
$C$8 = “B”

4. For the Value_if_true field, the formula is ‘DSS Model’!B18*(1+’DSS Model’!$G$6).

5. For the Value_if_false field, the formula is ‘DSS Model’!B18*(1+’DSS Model’!$G$5).

6. When done, if you click on the cell you should see the following formula in the formula bar:

=IF(‘DSS Model’!$C$8 = “B”,’DSS Model’!B18 * (1+’DSS Model’!$G$6), ‘DSS Model’!B18*(1+’DSS Model’!$G$5))

7. If you entered your formula correctly, you should see the value $455,000 in cell C3 on the Income and Cash Flow worksheet.
The formula for Cost of Goods Sold (cell C4) works the same way as the Sales(Revenue) calculation.
Cost of Goods Sold is a function of the inflation rate. If the inflation rate is higher, goods cost more to produce; if it is lower, goods cost less.
8. Click on cell C4.

9. Select IF from the Formulas tab.

10. Click in the Logical_test field. Click on cell C9 of the DSS Model worksheet then type =L.

11. For the Value_if_true field, the formula is ‘DSS Model’!B19*(1+’DSS Model’!$G$14)

12. For the Value_if_false field, the formula is ‘DSS Model’!B19*(1+’DSS Model’!$G$13)

NOTE:  You may get an alert telling you that you are missing a parentheses; click “Yes” to fix the problem.

13. If you entered the formula correctly, you should see the value -$249,900 in cell C4 for the Cost of Goods Sold.  The formula should look like this:

=IF(‘DSS Model’!C9=”L”,’DSS Model’!B19*(1+’DSS Model’!$G$14),’DSS Model’!B19*(1+’DSS Model’!$G$13))

14. If you change the input values to R and H on the DSS Worksheet, the values should change to $402,500 and negative $259,700.

15. Now repeat the processes above to calculate the Sales and Cost of Goods Sold for the Income and Cash Flow Statements (no New Line) table.  Remember to use the appropriate growth rates for No New Line.

[image: Macintosh HD:Users:test:Desktop:Screen Shot 2013-04-24 at 1.57.26 PM.png]If you left your inputs unchanged (R & H), you should have the values $367,500 and $259,700 for Sales and Cost of Goods Sold respectively. 


Step 7: Finishing out the Model
It is now time to finish populating the different cells in the model.
1. Click on the DSS Model worksheet tab.

2. Create formulas for Sales (Revenue) and Cost of Goods Sold that get the appropriate values from the Income and Cash Flow worksheet. Do this for both Calculations tables.

3. Copy and paste the formulas you just created in the appropriate cells in the column for 2014.

4. Copy and paste the formula for Cost of Goods Sold (as a percent of Sales) to the columns for 2013 and 2014 in both Calculations tables.

5. Copy and paste cell formulas from C12:C:15 to D12:D15.

6. Click on the Income and Cash Flow worksheet.

7. Copy and paste the Sales (Revenue) and Cost of Goods Sold formulas from the 2013 column to the 2014 column for both tables.
You model should now be complete and look like this:[image: ]

And your Income and Cash Flow Statement should look like this: 
[image: Macintosh HD:Users:test:Desktop:End pic 2.png]
Step 9: Experiment with different conditions.
Now that you have your model constructed, experiment with changing the economic and inflation outlooks.
Step 10: Save and Submit
Make sure your file is saved. Upload the file to the Activity 4 Drop-Box. Your assignment will be graded using the following rubric:
	Category
	Points

	DSS Model Setup Correctly
· Formulas correct (5pts)
· Formatting Correct (5pts)
· Logical Functions and Payment Functions done correctly (10pts)
· [bookmark: _GoBack]Absolute cell references used when needed correctly (5pts)
	25

	Total:
	25pts
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6 Boom-B 30% 20%
7 |Inputs 2012 2013 2014

8 [Economic Outlook (R = Recession, B = Boom) NA R NA

9 |Inflation Outlook (H = High, L = Low) NA H NA

10

11 Summary of Key Results 2012 2013 2014 Inflation Outlook Assumptions

12 Net Income After Taxes (New Line) NA $86,573 $113,104 Inflation Rate

13 End-of-year Cash on Hand (New Line) NA $101,573  $214,677 High-H 6%

14 | Net Income After Taxes (No New Line) NA $72,226 $71,885 Low-L 2%

15 End-of-year Cash on Hand (No New Line) NA $87,226 $159,111

16

17 Calculations (New Line) 2012 2013 2014

18 Total Sales Dollars $350,000  $402,500 ~ $462,875

19 Cost of Goods Sold -$245,000 -$259,700 -$275,282

20 | Cost of Goods Sold (as a percent of sales) 70.0% 64.5% 59.5%

21 |Interest Rate for Business Loan NA 6.0% NA

22

23 |Calculations (No New Line) 2012 2013 2014

24 |Total Sales Dollars $350,000  $367,500  $385,875

25 |Cost of Goods Sold -$245,000 -$259,700 -$275,282

26 | Cost of Goods Sold (as a percent of sales) 70.0% 70.7% 71.3%

27
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